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WAT IS NIEUW? 
 
Met genoegen kondigen wij de release aan van versie 8.3 van ONESOURCE Corporate Tax voor Nederland. Met deze 
release kunt u voor binnenlands belastingplichtigen aangiften vennootschapsbelasting maken voor het fiscale jaar 2015 
(2015/2016). Deze release bevat een aantal vernieuwingen, verbeteringen en aanpassingen.  
 
De release is beschikbaar vanaf uw download site. In aanvulling op de installatie van de software, is er een update nodig 
van de SQL Server fiscale eenheidsdatabase. U treft het update script aan in het release-pakket. 
 
Als u gebruik maakt van ONESOURCE Corporate Tax in de hosted omgeving, hoeft u geen actie te ondernemen; de 
nieuwe release is inmiddels beschikbaar. 

Aangiftebiljet 2015, uitstel en voorlopige aanslagen 2016 

Enkelvoudige- en fiscale eenheidsaangiften 2015 van binnenlands belastingplichtigen kunnen thans worden gemaakt in 
ONESOURCE Corporate Tax, wat is geüpdate met de laatste wetgeving, specificaties, belastingtarieven en XBRL-
vereisten. 
 
U kunt nu ook via ONESOURCE Corporate Tax verzoeken om (i) uitstel van indiening van 2015 aangiften, (ii) voorlopige 
aanslagen 2016 en (iii) 2016 SBA’s. 

GENERAL LEDGER MANAGER 
 
Met deze release kunnen wij u een nieuwe optie aanbieden om data te verzamelen voor uw ONESOURCE Corporate 
Tax berekeningen door de integratie te ondersteunen met onze General Ledger Manager (GLM) oplossing. 

General Ledger Manager is een web based dataverzameltool die wordt gebruikt om de datastroom van uw 

grootboek/proefbalans te automatiseren in ONESOURCE Corporate Tax. GLM integreert tevens met onze Dataflow- en 

Tax Provision-oplossingen.   

GLM biedt u de mogelijkheid om: 
 

 Een fiscaal hoofdrekeningschema (Master Chart of Accounts) te definiëren, resp. meervoudige 
hoofdrekeningschema’s voor verschillende doelen/bedrijfstypes 

 Data te importeren van meervoudige ERP-, grootboek- en boekhoudsystemen (elk potentieel met een 
verschillend rekeningschema) en data te consolideren van rapporterende entiteiten en divisies om een 
enkelvoudige hoofdproefbalans te kunnen produceren op een juridisch entiteitenniveau 

 Proefbalansen te vergelijken en handmatige aanpassingen op proefbalansen te maken  

 Data automatisch te importeren in de financiële informatieschema’s in ONESOURCE Corporate Tax  
(commerciële balans – schema B; en commerciële winst- en verliesrekening – schema C) 

 Een duidelijke audit trail te verkrijgen van de herkomst van data vanaf de aangifte naar de bron 

 Eenvoudig data te importeren/exporteren door middel van proefbalansmappings en het delen van mappings over 
entiteiten en periodes 

Dit heeft de volgende voordelen: 

 Het reduceren van werkzaamheden voor het transporteren van data van de bron naar de aangiften en andere 
processen, zoals rapportage 

 Werken met grote aantallen entiteiten, mappings en grote hoeveelheden data 

 Reviewen en managen van uw werk 

 Standaardiseren van uw aangiften 

SUB-CONSOLIDATIEBESTANDEN 
 
ONESOURCE biedt ondersteuning bij de consolidatierangorde door het gebruik van onze nieuwe sub-
 consolidatiemodule. Sub-consolidaties bieden u meer flexibiliteit in de structurering van uw bestanden en geven een 
beter beeld van de samenstelling van de fiscale eenheidscijfers. In aanvulling op enkelvoudige bestanden die direct zijn 
gelinkt aan de fiscale eenheid, heeft u de mogelijkheid om één of meerdere sub-consolidatiebestanden toe te voegen aan 
de fiscale eenheid.  
 
Als onderdeel van deze toepassing kunt u kiezen of de sub-consolidatiebestanden (i) zelf juridische entiteiten zijn met 
daarin een sub-consolidatie van onderliggende divisiebestanden (reporting entities), of (ii) zelf geen juridische entiteiten 
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zijn, maar juist de sub-consolidatie van onderliggende juridische entiteiten. Dit maakt dat u beter in staat bent om uw 
bedrijfsstructuur te splitsen in gepaste groepen.  
 
Potentiële voordelen van het toepassen van sub-consolidatiebestanden in uw bestandsstructuur zijn: 
 

 Meerdere gebruikers kunnen gelijktijdig aan de consolidatie werken 
Aangezien slechts één gebruiker schrijftoegang heeft tot de fiscale eenheid, geeft het splitsen van de fiscale 
eenheid in kleinere sub-consolidaties u en uw collega’s de mogelijkheid om gelijktijdig verschillende delen van uw 
consolidatiestructuur voor te bereiden en versnelt het uw proces. 

 Snellere interactie met de fiscale eenheidsdatabase 
Grote fiscale eenheden kunnen grote hoeveelheden data inhouden, hetgeen betekent dat het updaten van de 
fiscale eenheidsdata enige tijd in beslag kan nemen. Door het verdelen van de fiscale eenheid in sub-
consolidaties op deze nieuwe manier kunt u de datastroom van de database reduceren, wat leidt tot snellere 
uitvoering. 

 Divisiebestanden 
Veel van onze cliënten hebben hun interesse uitgesproken in het maken van berekeningen op divisieniveau 
(reporting entities) om aan te sluiten bij hun brondata en om dit samen te brengen in een juridische entiteit in 
ONESOURCE Corporate Tax. We hebben dit thans ondersteund met W-bestanden die worden aangemerkt als 
divisies (niet-juridische entiteiten). Hierdoor verlichten we de beperkingen en vereisten die u anders nodig heeft 
voor een divisie. Wij ondersteunen de verwerking van deze divisies in een sub-consolidatiebestand van een 
juridische entiteit. 

Mogelijke bestandsstructuur met sub-consolidaties 

Er is veel flexibiliteit in hoe u uw bestanden structureert met sub-consolidaties.  
 

Fiscal Unity file
 

Company File A
 

Company File B
 

Sub-consolidation
1 

Sub-consolidation
2

Sub-consolidation
 3 

Legal entity

Division A
 

Division B
 

Division C
 

 
 
Zoals u in dit voorbeeld ziet, kan de bestandsstructuur heel eenvoudig zijn, aangezien Sub-consolidation 1, waar de 
enkelvoudige bestanden zijn gelinkt aan een sub-consolidatie, direct is gelinkt aan de fiscale eenheid.  
 
Sub-consolidation 3 laat zien dat de sub-consolidatie een juridische entiteit kan zijn met enkelvoudige bestanden die zijn 
gelinkt aan onderliggende divisies. 
 

 
 
 
 
 

 

 

 

Fiscal Unity file
 

Division A
 

Division B
 

Sub-consolidation
 3 

Legal entity
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U kunt net zoveel sub-consolidatiebestanden tussen de enkelvoudige bestanden en de fiscale eenheid gebruiken als u 

wenst: 

Fiscal Unity file
 

Company File A
 

Company File B
 

Sub-consolidation
1 

Sub-consolidation
 …..Sub-consolidation

2

 

Het maken van sub-consolidatiebestanden 

Sub-consolidatiebestanden zijn toegevoegd als nieuwe optie in het menu: creëer 
nieuw bestand. 
 
Momenteel zijn sub-consolidaties alleen beschikbaar voor aan aangiften van 
binnenlands belastingplichtigen vanaf 2015.. 
 
De basishandelingen bij een sub-consolidatiebestand lijken veel op die bij een 
fiscale eenheidsbestand. Het fiscale eenheidscontroleschema (F) geeft een 
overzicht van welke bestanden zijn gelinkt aan de sub-consolidatie. Hiervandaan 
kunt u vennootschappen linken aan, of verwijderen van, de consolidatie en de data 
van de database updaten. 
 
Deze opties zijn ook beschikbaar in het File > Link menu, waar u zult zien dat de 
optie ‘Upload company data for fiscal unity’ beschikbaar is die informatie uploadt op 
sub-consolidatieniveau, bijvoorbeeld de balansinformatie, die consolideert in de 
fiscale eenheidsdatabase. Data wordt tevens geüpload naar de database als het 
bestand wordt bewaard op dezelfde wijze als de enkelvoudige bestanden. 
 
Andere opties op het F-schema, zoals ‘Open, update and close all files’ en ‘Set status of all files to…’ zijn ook 
beschikbaar in sub-consolidatiebestanden. Deze handelingen worden verricht in alle bestanden in de ketting, bijvoorbeeld 
in de structuur hierboven zorgt het kiezen voor ‘Set status of all files to…’ ervoor dat Sub-consolidation 2 verandert in de 
bestandenstatus van Company A, Company B en Sub-consolidation 1. Let op: deze handeling wordt niet verricht in het 
bestand zelf of enig ander bestand hoger in de structuur, d.i. het fiscale eenheidsbestand. 
 

Dataconsolidatie bij het gebruik van sub-consolidatiebestanden 

Om het gebruik van sub-consolidaties zo efficiënt mogelijk te maken, hebben we verschillende methodes van 

consolideren, verzamelen en terugplaatsing gebruikt om aan te sluiten bij het type informatie binnen uw bestanden. 

Bijvoorbeeld, om het voor u mogelijk te maken om balans- en winst- en verliesrekeningaanpassingen en eliminaties op 

elk niveau in de structuur door te voeren, wordt data voor die schema’s gehaald van het niveau direct eronder. Gebruik 

makend van de eerste bestandsstructuur zoals hierboven getoond als voorbeeld, wordt de balans van Company A en 

Company B geconsolideerd in Sub-

consolidation 1. Het fiscale eenheidsbestand 

zal dan het geconsolideerde bedrag van Sub-

consolidation 1 tonen, in plaats van de 

onderliggende enkelvoudige data. 

 

 
Het F2-schema in het fiscale eenheidsbestand  
toont 1 kolom voor ‘Subconsolidation 1’. 

 

 



ONESOURCE Corporate Tax NL 8.3 Release Notes 

 

Page | 6 
 

Data van de belastbaar bedrag aanpassingen (T-schema’s) en voorkoming dubbele belasting zijn niet op ieder niveau 
geconsolideerd, maar de data op het laagste niveau wordt direct getoond in de consolidatiebestanden. 
 
Ten behoeve van het indienen dient een fiscale eenheid bepaalde informatie te laten zien die is geconsolideerd op het 
niveau van de juridische entiteit. Items zoals verliescompensatie kunnen alleen op het niveau van de juridische entiteit 
worden berekend en worden zodoende geüpload in het fiscale eenheidsbestand vanuit het bestand van de juridische 
entiteit, hetgeen een enkelvoudig bestand of een sub-consolidatiebestand kan zijn. 

Verliesverrekening
BS/PL data voor L4/L5 sheets

BS/PL data of 
entiteit

BS/PL data of 
sub-consoidation

Fiscale eenheid correcties
Verliesverrekening data

BS/PL data of 
entiteit

Belastbaar bedrag(T-sheet) aapassingen
Voorkoming dubbele belasting

 Juridische entiteit
(bedrijfs of 

subconsolidatie 
bestand)

Bedrijfs- of 
divisiebestand 

(niet- juridische 
entiteit)

Sub-consolidatie
bestand

Fiscale eenheid

 
Een samenvatting van een data flow in een sub-consolidatiebestand structuur. 

 
Voor een volledig overzicht over hoe data wordt getransfereerd in sub-consolidatiestructuren, verwijzen wij u naar  
Bijlage A. 

Fiscale eenheidsaanpassingen en verliescompensatie 

Aangezien fiscale eenheidsaanpassingen en verliescompensatie worden gemaakt tussen juridische entiteiten, worden 

deze teruggeplaatst in het bestand van de juridische entiteit vanuit het fiscale eenheidsbestand op dezelfde wijze alsof er 

geen gelinkte sub-consolidatiebestanden zouden zijn.  

Let op dat fiscale eenheidsaanpassingen in een sub-consolidatiebestand uitsluitend ter informatie zijn en niet worden 

teruggeplaatst in het bestand van de juridische entiteit. 

DEELNEMINGEN 
 
Veel van onze cliënten hebben een groot aantal deelnemingen en zijn door de belastingdienst gevraagd om meer 
informatie te verstrekken over de deelnemingen. Dit houdt verband met de limiet van 99 deelnemingen voor e-filing. We 
hebben nauw samengewerkt met de belastingdienst om de situatie op te lossen waar bedrijven meer dan 99 
deelnemingen hebben. Daartoe hebben we een nieuwe Specificatie: deelnemingen schema ontwikkeld.   

Dit schema is ontwikkeld als onderdeel van uw Belastingaangifte voor e-filing groep van schema’s voor binnenlandse  

aangiften en is consistent met de lay-out van andere schema’s in deze groep. 

 
 
 
 
Waar u vanaf 2015 100 of meer deelnemingen heeft, is de verwerking enigszins afwijkend van voorgaande jaren. Deze 
verschillen zijn de uitkomst van het overleg met de belastingdienst teneinde de informatie te verschaffen die zij nodig 
hebben. 

 Uw deelnemingen worden gesorteerd, met bovenaan de deelnemingen waar de autoriteiten de meeste 

belangstelling voor hebben  
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 De naam van de laatste (99ste) deelneming wordt “Summary of other participations" 

o   

 Binnen deze “overige” categorie (i) worden sommige waarden samengevoegd (bijv. de kostprijs), (ii) wordt voor 

andere informatie de waarde overgenomen van de meest relevante deelnemingen (bijv. fiscaal nummer) en (iii) 

worden sommige waarden niet verschaft (bijv. fusie/splitsingsinformatie) 

Met deze wijziging hebben wij tevens Specificatie – deelnemingen (D) schema print gewijzigd, die nu de gehele lijst van 

deelnemingen, inclusief binnen- en buiten de fiscale eenheid, in de definitieve print bevat.  

Om uw deelnemingen gemakkelijker te kunnen benaderen, hebben we het mogelijk gemaakt om snel meerdere 

schema’s voor deelnemingen tegelijk te ontwikkelen, door middel van een nieuwe optie: 

- Toolbar: Tools > Application tools > Add multiple participation schedules 

- Ribbon bar: Applicatie Tools > Meerdere deelnemingsschema’s toevoegen 

Het klikken op deze optie laadt een venster waarin u het aantal deelnemingenschema’s kunt specificeren wat u wenst toe 

te voegen aan uw aangifte.  

F-SCHEMA FUNCTIONALITEIT IN FISCALE EENHEIDS- EN   
SUB-CONSOLIDATIEBESTANDEN 
 
U zult merken dat we wat wijzigingen hebben aangebracht in het fiscale eenheidscontroleschema (F). hetgeen het proces 
van de afronding van uw consolidaties efficiënter en eenvoudiger zou moeten maken. Deze verbeteringen zijn 
beschikbaar vanaf de 2015 aangiften. 

 
 
 
 

 
 

 
 
 
 
 
 
 
 

Het nieuwe uiterlijk van het F-schema in de 2015 consolidatie-bestanden 

Bulkwijziging van bestandsstatus 

We hebben de ‘Set status of all files to CLIENT’ knop op het F-schema (zie boven figuur 1) verplaatst om het flexibeler te 
maken. In plaats van het instellen van de status voor alle onderliggende bestanden gelinkt aan de fiscale eenheid op 
“CLIENT”, heeft u nu de mogelijkheid om iedere status te selecteren waar u de bestanden op wilt hebben. Dit geeft meer 
vrijheid om uw statussen aan te passen en ze op een logische manier te gebruiken in de fiscale eenheid. Het scheelt u 
ook tijd bij het vrijgeven van alle bestanden, terwijl het password en de audit controle gelijk zijn aan deze handeling bij 
een “per bestand” verwerking. 
 
Om deze functionaliteit te gebruiken, selecteert u een status in het drop-down menu onder de bestandstatus kolom 
(rechts binnen 1), vervolgens gebruikt u de ‘Set status of all files to …’ knop. Dit stelt de status van alle bestanden in uw 
consolidatie in op de gewenste status.  Let op: als u sub-consolidatiebestanden in uw bestandsstructuur heeft, zal deze 
functie de status instellen voor alle bestanden daaronder in de structuur, bijv. het selecteren van deze optie in een fiscale 
eenheid wijzigt de status voor alle sub-consolidatiebestanden en eveneens alle bestanden die zijn gelinkt aan die sub-
consolidatiebestanden.  
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Foutmeldingen in gelinkte bestanden 

U zult ook zien dat we een telling van foutmeldingen hebben toegevoegd in de bestanden die zijn gelinkt aan het F-

schema (2). Dit helpt u om snel en gemakkelijk te identificeren welke onderliggende bestanden vraagpunten hebben die 

moeten worden opgelost voordat de fiscale eenheidsaangifte kan worden afgerond. 

Waar van toepassing, worden het aantal onbeantwoorde vragen, oude link foutmeldingen en data invoer foutmeldingen in 

ieder bestand getoond.  

Let op: De telling van foutmeldingen wordt geüpdate via de fiscale eenheidsdatabase, zodat een verbinding met de 

database vereist is voor deze update. 

Keuzetoets moedermaatschappij 

We hebben ook wat wijzigingen aangebracht aan de keuzetoets moedermaatschappij. Door te klikken op ‘Select parent 

company” (3), verschijnt een venster met een lijst van alle juridische entiteiten in de (sub)consolidatie. Als u de 

moedermaatschappij wilt de-selecteren, gebruikt u  de ‘Clear parent company’ knop. 

Als de moedermaatschappij niet is opgenomen in een sub-consolidatie, kunt u de foutmeldingen in relatie met de 

afwezigheid van een moedermaatschappij negeren. 

Batch printen van bestanden in consolidaties 

Verder kunnen we u berichten dat de ‘Print all files in fiscal unity’ functionaliteit die we eerder hebben geïntroduceerd 
thans is gefinaliseerd en er een aantal belangrijke verbeteringen is doorgevoerd. 
 

 
Nieuwe opties zijn nu beschikbaar onder Tools > 
Application tools > Batch print files in fiscal 
unity/subconsolidation’ bij gebruik van de tool bar, of 
Application tools > Print all files in fiscal 
unity/subconsolidation’ bij gebruik van de ribbon bar. 

 
 

 
De  batch print optie in een fiscale eenheidsbestand 

 
Om u meer flexibiliteit en controle te geven, hebben we 3 opties hoe bestanden te printen:  
 

 Print alle gelinkte bestanden print alle bestanden in uw bestandsstructuur. Als de bestandsstructuur sub-
consolidaties bevat, zal deze optie alle sub-consolidatie-, bedrijfs- en divisiebestanden printen. 

 Print alle bestanden vermeld op het F schema print alleen de bestanden die zijn gemeld op het F-schema. Als 
daar sub-consolidatiebestanden bij zijn, wordt het sub-consolidatiebestand geprint, maar niet de bestanden 
daaronder. 

 Print alle jurisiche entiteiten kijkt door de bestandsstructuur heen en print alle bestanden die zijn verantwoord 
als juridische entiteiten. 

FISCALE VERMOGENSSPRONG  
 
Het verklaren van een vermogenssprong is een uitdagend en tijdrovend onderdeel van de fiscale eenheidsconsolidatie.  
Vanaf 2015 hebben we een schema ontwikkeld om uw aansluiting te rapporteren. Het nieuwe Fiscal Unity Equity Pick Up 
schema is ontwikkeld in Fiscale eenheidscontrole-schema (F) in uw binnenlandse fiscale eenheids-consolidatiebestand  
(xxx_Fxx.ABC).  
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Voor iedere deelnemer (1) binnen de fiscale eenheid, sluit dit nieuwe schema de positie aan voor het vermogen volgens 
de balans van de dochtermaatschappij (4) met de geconsolideerde deelnemingspositie op de balans van de 
moedermaatschappij (3).  Deze vergelijking wordt tot stand gebracht door gegevens te vergelijken op basis van het 
fiscaal nummer van de deelneming zoals gerapporteerd op het niveau van de moedermaatschappij (2) en het fiscaal 
nummer van de betreffende deelneming als dochtermaatschappij in de consolidatie (F-schema’s). Waar verschillen 
optreden, wordt het verschil afgezet tegen het resultaat volgens de winst- en verliesrekening en gerapporteerde 
dividenden (5) voor iedere deelneming en een additionele kolom voor andere handmatige aanpassingen om te komen tot 
uw netto vermogenssprong (7).   
 
In het geval u buitenlandse fiscale eenheidsdeelnemers heeft, hebben we voorzien in een additionele tabel (6) zodat u 
handmatig een soortgelijke aansluiting kunt maken voor dergelijke deelnemers. 
 

SERVERRAPPORTAGE VERBETERINGEN 
 
We hebben de serverrapportage-functionaliteit verbeterd door het uitbreiden van het aantal items waar u rapporten voor 
kunt genereren. 
 
U kunt rapporteren op meer balans onderdelen en winst- en verliesrekening onderdelen via de aangifteschema’s 
(‘Balance sheet – Assets’, ‘Balance sheet – Shareholders’ equity and liabilities’ and ‘Profit and loss account’), hetgeen u 
een meer gedetailleerd overzicht verschaft voor het fiscale jaar. U kunt rapporteren vanaf de Tax Return schema’s (A1xx), 
Participations (D), Taxable Income (T), Loss Compensation (U) en Tax Calculation (V). 
 
We maken via de nieuwe templates ook standaardrapporten beschikbaar voor verschillende categorieën. Voor een 
volledige lijst van standaardrapporten die worden toegevoegd voor het komende jaar verwijzen wij u naar Bijlage B. 
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OVERIGE VERBETERINGEN 

Bovenmatige deelnemingsrente 

In deze release hebben we onze berekening van de bovenmatige deelnemingsrente verbeterd. De deelnemingsschuld is 
nu gebaseerd op het gemiddelde van de deelnemingsschuld per begin en einde van het fiscale jaar. Tevens kunt u nu de 
opgenomen leningen en interest op bruto-basis rapporteren en aanpassingen maken als interest op opgenomen leningen 
inmiddels niet-aftrekbaar is op basis van andere Nederlandse vennootschapsbelastingwetgeving.  

Irrelevante vragen op het A-schema kunnen worden verborgen 

We hebben een keuzeknop toegevoegd (‘Algemene gegevens volledig weergeven”) onderaan het Algemene informatie-
schema (A) om het mogelijk te maken om informatie te tonen/verbergen die niet verplicht is om in te dienen bij de 
belastingdienst volgens hun elektronische indienspecificaties.  Standaard zal de niet verplichte informatie worden 
verborgen. Echter, als de voornoemde keuzeknop op JA is gezet, wordt de algemene informatie, conform voorgaande 
jaren, volledig getoond..  
 

 

Het niet-verplichte deel van het A9-schema is verwijderd 

Het niet-verplichte deel van het Algemene informatie en specificaties – Pagina 2  schema (A9) welke aangeeft welke 
specificaties moeten worden ingediend bij de belastingdienst, is verwijderd. Dit komt doordat de verplichte 
aangiftespecificaties automatisch worden opgenomen in de voor de elektronische indiening gegenereerde XBRL file, 
zodat additionele specificaties niet nodig zijn. 

Kleine verbeteringen m.b.t printen, algemene functionaliteit en lokalisatie 

Conform releases in voorgaande jaren hebben we de print- en algemene functionaliteit verbeterd en de software verder 
land specifiek gemaakt.   
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BIJLAGEN 

BIJLAGE  A: CONSOLIDATIE VAN DATA IN BESTANDSSTRUCTUUR MET SUB-CONSOLIDATIE-
BESTANDEN 

Consolidatie type Schema naam Schema 
referentie 

Schema’s welke 
consolideren op ieder 
niveau 

Balans 
 

B 

Winst- en verliesrekening C 
Interactie is direct tussen 
fiscal eenheidsbestand en 
bestand juridische entiteit 

Enkelvoudige data L4, L5 
 

Verliesverrekening U4, U7 
Genereert van laagste 
bestandsniveau (divisie of 
entiteitsbestand) 

T schema’s:  

Niet-aftrekbare kosten T4 

Investeringsaftrek T5  

Desinvesteringsbijtelling T6 

Niet-aftrekbare interest T8 

Aftrekbare giften T10 

Fondsenwerving T13 

Niet-aftrekbare interest en royalties (art. 8c Wet Vpb) T16 

Winst uit zeescheepvaart T17 

Specificatie - Innovatie box T19 

Specificatie - Objectvrijstelling T21 

Specificatie - Onderzoek en Ontwikkeling T22 

Bovenmatige deelnemingsrente T25 

V schema’s – Voorkoming dubbele belasting  

Vrijstellingsmethode V1 

Verrekeningsmethode voor dividenden, interest en 
royalties 

V2 

Verrekeningsmethode voor buitenlands inkomen van 
laagbelaste buitenlandse investeringsondernemingen 

V7 

Royalties in innovatie box V8 

Deelnemingen D2 

BIJLAGE B: STANDAARD RAPPORTEN BIJ SERVERRAPPORTAGE 

Onderstaand is een lijst van standard rapportages welke beschikbaar gemaakt zullen worden voor het gebruik van 

serverrapportage. Deze templates zullen gedurende het jaar beschikbaar komen. 

 

 Materiële vaste 

activa 
 Verplichtingen en voorzieningen  Financiële opbrengsten en kosten 

 Financiële vaste 

active 
 Langlopende schulden  Resultaten van deelnemingen 

 Voorraden  Kortlopende schulden  Buitengewone baten 

 Vorderingen  Bedrijfsopbrengsten  Buitengewone lasten 

 Effecten  Kostprijs van verkopen  Fiscaal resultaat 

 Liquide middelen  Personeelskosten  Aansluiting fiscaal belastingbedrag 

 Eigen vermogen  Afschrijvingen  Totaal te betalen belasting 

 Vermogen  Overige bedrijfskosten 
 

 Deelnemingen  Achterwaartse verliesverrekening 
 


